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Po~etak 
rada

LightWave 3D je podeljen na dve glavne
komponente – Layout, u kojoj se obavlja
sva animacija, renderovanje i najve}i deo
pravljenja povr{ina, i Modeler, u kojoj
kreirate svoje 3D objekte, dodeljujete mape
ta~aka (vertex maps) i defini{ete njihove
povr{ine. Pre nego {to po~nete da koristite
Layout i Modeler, potrebno je da se upo-
znate sa njihovim interfejsima. Iako je
op{ti  raspored alatki u njima isti, zadaci
koje one obavljaju nisu, tako da }ete
prona}i neke zna~ajne razlike. 

U ovom poglavlju }emo vam prikazati
interfejse Layouta i Modelera i upoznati
vas sa komponentom Hub, koja funkci-
oni{e kao provodnik podataka izme|u
druge dve komponente.

1



Paleta sa 
alatkama

Kartice
OpenGL prikaz

Kliza~ kroz kadrove
Informaciono-
numeri~ka polja

Prozor za poruke
Meni aktivnog elementa 

Re‘imi ure|ivanja

Alatke za klju~ne kadrove

Linija vremenskog sleda
Kontrole prikaza

Interfejs komponente
Layout
Pogledajmo najpre interfejs komponente
Layout (slika 1.1).

Paleta sa alatkama: U paleti sa
alatkama se nalaze alatke za animaciju
komponente Layout. Alatke su grupi-
sane po funkciji, {to olak{ava njihovo
pronala`enje. Mo`ete primetiti da je,
ukoliko za odre|enu alatku postoji,
pre~ica na tastaturi prikazana na
tasteru alatke (slika 1.2).
Kartice: Klikom na karticu menjaju se
alatke koje su prikazane u paleti. Kako
budete prelazili iz jedne u drugu karticu,
mo`ete primetiti da se tasteri koji se
nalaze ispod odeljka Presets ne menjaju,
tako da su ove alatke i editori koji se
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~esto koriste uvek dostupni, bez obzira
na to na ~emu radite.
OpenGL prikaz: U ovom prostoru }ete
raditi na svojoj 3D sceni, manipulisati
elementima i praviti prikaze svog rada.
U poglavlju 2, “Obilazak prikaza”, opi-
sani su OpenGL prikazi komponenti
Layout i Modeler.
Kontrole prikaza: Ove kontrole omogu-
}avaju prikaz odre|ene scene napred ili
unazad, ili pojedina~ni pregled svakog
njenog kadra.
Alatke za klju~ne kadrove: Ovi tasteri
slu`e za uklju~ivanje i isklju~ivanje
automatskog ubacivanja klju~nih
kadrova, kao i za otvaranje okvira za
dijalog Create Motion Key i Delete
Motion Key.

Slika 1.1 Interfejs komponente Layout se koristi za animaciju elemenata i dodavanje povr{ina,
osvetljavanje scene i renderovanje kona~nih slika.



Meni aktivnog elementa : U ovom
padaju}em meniju prikazan je naziv
trenutno izabranog elementa. Klikom
na ovaj meni dobi}ete listu elemenata
koje mo`ete izabrati u trenutnom
re`imu ure|ivanja.
Prozor za poruke: U ovom polju je
pri-kazano ime alatke koju trenutno
kori-stite, kao i poruke komponente
Layout. 
Re`imi ure|ivanja: Ovi tasteri se kori-
ste za kontrolu re`ima ure|ivanja koji
tre-nutno koristite. Ako kliknete na
taster Objects, mo}i }ete da manipuli-
{ete bilo kojim objektom u sceni, kada
kliknete na taster Lights mo}i }ete da
manipuli{ete osvetljenjem, i tako dalje.
Ukoliko u prostoru za prikaz kompo-
nente Layout izaberete neki element
razli~itog tipa od trenutnog re`ima
ure|ivanja, re`im ure|ivanja }e se
automatski promeniti kako biste mogli
da po~nete da radite na odabranom
elementu.
Kliza~ kroz kadrove: Koristite kliza~
kroz kadrove kako biste kontrolisali
vreme va{e animacije u komponenti
Layout, podesili njegovo ukupno tra-
janje, izabrali vreme po~etka i kraja i
izabrali koji kadar }e trenutno biti
prikazan.
Linija vremenskog sleda: Koristite
ovu liniju kako biste manipulisali
klju~nim frejmovima u vremenu.
Informaciono-numeri~ka polja: Sadr`aj
ovih polja se menja zavisno od alatke
koju trenutno koristite i stalno se a`u-
rira kako bi u njima bili prikazani rele-
vantni podaci. Kada, na primer, pome-
rate ne{to pomo}u alatke Move, u polju
}e biti prikazana pozicija tog elementa,
a kada rotirate ne{to pomo}u alatke
Rotate, bi}e prikazan ugao elementa.
Ova polja slu`e i kao polja za unos
brojeva, i u njima mo`ete unositi nove
vrednosti za razli~ite ose.
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Slika 1.2 Da biste saznali
pre~icu na tastaturi za odre-
|enu alatku, jednostavno
potra`ite bela slova na
ve}ini tastera u paleti sa
alatkama.



Interfejs komponente
Modeler
Pogledajmo sada i interfejs komponente
Modeler (slika 1.3).

Paleta sa alatkama: Kao i u kompo-
nenti Layout, paleta sa alatkama sadr`i
ve}inu alatki Modelera.
Kartice: Kao i u komponenti Layout,
izborom razli~itih kartica menjaju se
opcije koje se nalaze ispod odeljka
Presets u paleti sa alatkama. 
OpenGL prikaz: Modeliranje objekata
i manipulisanje njima }ete, kao i u
Layoutu, obavljati u prostoru prikaza.
Po osnovnom pode{avanju, Modeler
ima ~etiri prikaza, dok Layout ima
jedan. Broj i raspored ovih prikaza
mo`ete pode{avati u obe komponente
(pogledajte Poglavlje 2). 
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Meni aktivnog objekta: Ovde je uvek
prikazan objekat na kom trenutno
radite, koji }e, sve dok ga ne sa~uvate
sa imenom, biti nazvan “Unnamed”.
Tako|e, ako ste izmenili aktivni objekat,
a jo{ uvek niste sa~uvali izmene, pored
njegovog imena }e se nalaziti zvezdica
(slika 1.4). Otvorite ovaj meni da biste
videli listu drugih objekata koje
trenutno mo`ete menjati.
Banka slojeva: Ovi tasteri predstavl-
jaju slojeve va{eg objekta. Kliknite na
gornju polovinu tastera da biste odre-
|eni sloj aktivirali radi izmena, ili na
donju polovinu kako bi taj sloj bio
prikazan u pozadini. Tasteri u obliku
purpurnih strelica, sa leve strane banke
slojeva, vam omogu}avaju da se kre}ete
kroz raspolo`ive banke slojeva trenutno
aktivnog objekta. Po osnovnom pode-
{avanju, u banci slojeva su prikazani

Re‘imi izbora

Paleta sa alatkama Kartice Open GL prikazi Meni aktivnog objekta Banka slojeva

Pra}enje napretkaPrikaz informacija
Meni re‘ima Prozor za poruke Re‘imi ure|ivanja mapa

Slika 1.3 U interfejsu komponente Modeler mo`ete da pravite i menjate objekte, kao i da pravite grupe
povr{ina.



Meniji tastera mi{a
I Layout i Modeler koriste menije
tastera mi{a za ubrzavanje pristupa
mnogim funkcijama. Da biste
otvorili menije tastera mi{a,
istovremeno dri`ite tastere Ctrl i
Shift na tastaturi i pritisnite taster
mi{a (slika 1.5). Za svaki od tri
tastera na va{em mi{u postoji
posebni meni. (Napomena:
Korisnici operativnog sistema Mac,
~iji mi{ ima samo jedan taster, }e
mo}i da pristupe samo jednom
dodatnom meniju tastera mi{a.
Drugom takvom meniju mogu
pristupiti ako istovremeno dr`e
tastere Cmd, Ctrl i Shift i pritisnu
taster mi{a.)

slojevi 1 do 10, ali objekat mo`e imati
onoliko slojeva koliko `elite. Kretanjem
kroz banke slojeva mo`ete do}i do sva-
kog od njih. 
VMap metodi ure|ivanja: Ovi tasteri se
koriste za promenu re`ima ure|ivanja
mapa ta~aka (vertex map, skra}eno
VMap). Sve mape ta~aka odabranog
tipa (te`ina, tekstura ili promena
oblika) su navedene u aktuelnom
padaju}em meniju VMap sa desne
strane od ovih tastera.
Komande za ure|ivanje: Ovi tasteri vam
omogu}avaju da obavite standardne
operacije ure|ivanja kao {to su kopi-
ranje, dodavanje i poni{tavanje posle-
dnje izmene. 
Meni re`ima: Ovaj meni vam omogu-
}ava da izaberete mesto operacije mode-
liranja. Ako izaberete Action Center:
Mouse, a zatim pomo}u alatke Rotate
rotirate objekat, on }e se rotirati oko
trenutne lokacije kursora va{eg mi{a.
Re`imi izbora: Kao i kod re`ima ure|i-
vanja u Layoutu, ovi tasteri se koriste za
kontrolu re`ima izbora koji trenutno
koristite, a samim tim i vrste elemenata
sa kojima mo`ete da radite. Pomo}u
razmaknice mo`ete brzo prelaziti kroz
raspolo`ive alatke za ure|ivanje.
Pra}enje napretka: Ovde je prikazan
status (napredak) aktuelne operacije.
Uglavnom ne}ete mo}i da ga vidite,
osim ako obavljate slo`enu operaciju
sa dosta geometrijskih elemenata. 
Prozor za poruke: U ovom polju se
prikazuju jednostavna uputstva za
kori{}enje trenutno odabrane alatke,
kao i statusne poruke Modelera.
Prikaz informacija: Kao i informaciono-
numeri~ka polja u komponenti Layout,
i ovo polje se menja u zavisnosti od
alatke koju trenutno koristite i stalno se
a`urira kako bi prikazivalo relevantne
podatke. Me|utim, u Modeleru ovo
polje ne mo`e slu`iti za unos nume-
ri~kih vrednosti za razli~ite ose.
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Slika 1.4 Kad god izmenite
objekat, pojavljuje se zvezdica koja
zna~i “nije sa~uvano”. Bilo bi dobro
da ~esto snimate izmene objekata.

Slika 1.5 Meni levog tastera mi{a u Layoutu. Ovi
meniji omogu}avaju brz pristup nekim od ~e{}e
kori{}enih funkcija i mogu se konfigurisati.



Izmena interfejsa
programa LightWave
Obe komponente, Layout i Modeler, vam
nude mogu}nost izme{tanja menija i
tastera u interfejsu i menjanja kontekstnih
menija i pre~ica na tastaturi. Koriste}i tu
mogu}nost, mo`ete prilagoditi interfejs
sopstvenom na~inu rada. Mo`ete napraviti
po jednu verziju svakog radnog prostora u
kom su prikazane samo alatke koje ~esto
koristite, ~ime }ete smanjiti broj menija
kroz koje morate pro}i da biste ih prona{li.

Izmena interfejsa komponente
Layout:
1. Iz padaju}eg menija Edit, koji se nalazi

u paleti sa alatkama, odaberite Edit
Menu Layout (slika 1.6). (Isti taj meni
mo`ete koristiti i u Modeleru.)
Otvara se panel Configure Menus
(slika 1.7).

2. U hijerarhijskoj listi Menu, kliknite na
strelicu koja se nalazi pored stavke
Items ispod Main Menu kako biste
otvorili listu elemenata palete sa ala-
tkama za karticu Items (slika 1.8).
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Slika 1.6  
Koristite padaju}i
meni Edit u Layoutu
ili Modeleru da biste
pristupili mnogim od
njihovih opcija za
konfigurisanje.

Slika 1.7 U panelu Configure Menus mo`ete
menjati raspored tastera i menija u interfejsu.

Slika 1.8 U desnom okviru se nalazi hijerarhijski
prikaz aktuelnog izgleda menija.
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3. Kliknite na strelicu pored Add da
biste prikazali stavke u podgrupi Add
(slika 1.9).

4. U hijerarhijskoj listi Command kliknite
na strelicu pored Objects da biste prika-
zali listu dostupnih alatki Objects, a
potom skrolujte dok ne vidite stavku
Add Partigon (slika 1.10).

nastavak na slede}oj strani

Slika 1.9 Strelice za pro{irivanje zna~e da stavka
u listi predstavlja meni ili naslov grupe interfejsa.

Slika 1.10 U levom okviru je prikazana lista
funkcija koje se mogu staviti u interfejs. Stavke koje
se ve} nalaze u njemu su zatamnjene.



5. Prevucite stavku Add Partigon u desni
okvir, postavljaju}i svetlo-plavi indika-
tor njegovog polo`aja ispod stavke
Null (slika 1.11).

Ispod tastera Null u podgrupi Add u
paleti sa alatkama pojavi}e se taster
Add Partigon.

Panel Configure Menus sadr`i dve hijera-
rhijske liste. Lista Command sa leve strane
prikazuje trenutno dostupne alatke, a lista
Menu sa desne strane trenutni raspored
menija. Stavke koje su zatamnjene u listi
sa leve strane se ve} nalaze u nekom od
postoje}ih menija.

U listi Menus mo`ete videti naslove Top
Group, Main Menu, Left Mouse Button
Menu itd. Stavke ispod tih naslova pre-
dstavljaju menije datog dela interfejsa.
Naslov Top Group je specifi~an zbog toga
{to }e sve {to postavite ispod njega uvek
biti prikazano na vrhu palete sa alatkama,
nezavisno od toga u kojoj kartici se
nalazite. 

Tako|e, mo`ete primetiti da se pored
nekih stavki nalaze strelice, pored nekih
ta~ke, a pored ostalih nema ni~ega. Stavke
sa strelicama su naslovi menija, one sa
ta~kama su elementi ili tasteri menija, a
one koje nemaju nikakav simbol predsta-
vljaju grupe. Osim izmene sadr`aja posto-
je}ih menija, mo`ete i da kreirate sopstvene
kartice, {to je korisno za pode{avanje
posebnih grupa alatki za zadatke koje
~esto ponavljate.

Za kreiranje nove kartice:
1. Ponovite prvi korak prethodnog postu-

pka, “Izmena interfejsa komponente
Layout”.

2. Kliknite na stavku Main Menu u desnoj
hijerarhijskoj listi kako biste je izabrali. 

3. Kliknite na taster New Group (slika
1.13). Time }ete dodati novu stavku
ispod naslova Main Menu i ubaciti
karticu po imenu New Group u glavni
interfejs (slika 1.14).
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Slika 1.11 Da biste postavili taster dovoljno je da
ga jednostavno prevu~ete u grupu ili meni u
interfejsu u kom `elite da se on nalazi.

Slika 1.12 Ovo je va{ novi 
taster. Konfigurisanje interfejsa
LightWave-a postavljanjem alatki
koje ~esto koristite na dohvat ruke
je odli~an na~in da pobolj{ate svoj
proces rada.

Slika 1.13  Tasterom New Group kreira se meni 
ili grupa New Group.

Slika 1.14 Po{to ste kreirali novu grupu ispod
naslova Main Menu, u interfejsu }e se pojaviti 
nova kartica.



4. Kliknite na stavku New Group u listi
Menus na desnoj strani panela
Configure Panels. 

5. Kliknite na taster Rename i u okvir za
dijalog Rename Group ukucajte My
Tools; potom pritisnite Enter ili kliknite
na OK (slika 1.15). 

6. Kliknite na strelicu pored naslova
Cameras u listi Commands sa leve
strane kako biste prikazali sve raspolo-
`ive Camera alatke. 

7. Prevucite stavku Camera Zoom Factor
u desni okvir, tako da svetlo-plavi
indikator polo`aja stoji uvu~en ispod
stavke My Tools (slika 1.16). 

8. Pre|ite u karticu My Tools.

Sada bi trebalo da u  paleti sa alatkama
mo`ete da vidite taster Zoom Factor
(slika 1.17).

S A V E T

Mogli ste da primetite da smo vam rekli da svetlo-
plavi indikator polo`aja postavite ispod nove stavke
My Tools i da je obavezno morao da bude uvu~en.
Kada je indikator polo`aja uvu~en, to zna~i da }e
panel Configure Menus taj taster smestiti u grupu ili
meni ispod kog je postavljen.

U ve`bama u ovoj knjizi se podrazumeva
da koristite osnovnu konfiguraciju menija,
tako da }emo sada vratiti interfejs u nje-
govo osnovno stanje.

Vra}anje interfejsa u osnovno stanje:
1. Ponovite prvi korak postupka, “Izmena

interfejsa komponente Layout”.

2. U padaju}em meniju Presets, koji se
nalazi na desnoj strani gornjeg dela
panela Configure Menus, izaberite
Default (slika 1.18).

S A V E T

Iako ne mo`ete dodavati sopstvene prethodno
pode{ene menije, mo`ete sa~uvati svoju konfigu-
raciju menija pomo}u tastera Save u panelu
Configure Menus. Kasnije je mo`ete u~itati pomo}u
tastera Load.
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Slika 1.15 Svoje nove kartice mo`ete nazvati
kako god `elite.

Slika 1.16 Uvu~eni indikator polo`aja govori
Layoutu da ovaj taster postavi unutar menija.

Slika 1.17 Va{a nova kartica
My Tools sada sadr`i taster
Zoom Factor.

Slika 1.18 Ako `elite da
po~nete iznova, uvek
mo`ete lako vratiti
osnovni izgled menija.



Izmena pre~ica na
tastaturi
Kao {to smo ve} pomenuli, za razli~ite
alatke i editore mo`ete promeniti pre~ice
na tastaturi. Nemaju sve alatke pre~ice na
tastaturi prema osnovnim pode{avanjima,
tako da }ete mo`da `eleti da dodate pre~icu
za alatku koju ~esto koristite da biste
ubrzali proces rada. Isto tako, mo`da }e
vam biti lak{e da zapamtite pre~icu za
odre|enu alatku ako je podesite onako
kako vama odgovara. Panel Configure
Keys je po rasporedu i funkcijama skoro
identi~an panelu Configure Menus.

Kreiranje pre~ica na tastaturi:
1. Iz padaju}eg menija Edit koji se nalazi

u paleti sa alatkama izaberite Edit
Keyboard Shortcuts. (Isti meni mo`ete
koristiti i u Modeleru.)

Time se otvara panel Configure Keys
(slika 1.19).

2. Kliknite na strelicu pored stavke
Cameras u hijerarhijskoj listi Command
sa desne strane kako biste otvorili listu
dostupnih alatki povezanih sa opcijom
Cameras.

3. Prevucite stavku Add Camera u listu
Key Command na desnoj strani, tako
da svetlo-plavi indikator polo`aja bude
postavljen iznad stavke “c”, kako biste
joj dodelili taj taster (slika 1.20).
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Slika 1.19 Otvorite panel Configure Keys na isti
na~in na koji ste ranije otvorili panel Configure
Menus.

Slika 1.20 Da biste odre|enoj komandi dodelili
pre~icu na tastaturi, jednostavno je prevucite tako da
se indikator polo`aja nalazi iznad `eljenog tastera.



4. Kliknite na taster Done kako biste
zatvorili panel Configure Keys.

5. Kliknite na karticu Items kako biste
videli nove opcije u paleti sa alatkama
(slika 1.21).

6. Pogledajte grupu alatki Add u paleti sa
alatkama.

Pored stavke Camera se sada nalazi “c”,
{to ozna~ava njenu pre~icu na tastaturi
(slika 1.22).

S A V E T

Kao i kod menija, u ve`bama u ovoj knjizi se
podrazumeva da koristite osnovne pre~ice na tasta-
turi. Zato, kada zavr{ite sa eksperimentisanjem, u
meniju Presets koji se nalazi u panelu Configure Keys
izaberite opciju Default kako biste sve vratili u
osnovno stanje.
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Slika 1.21 Kliknite na karticu Items kako biste
dobili pristup novim opcijama u paleti sa alatkama,
uklju~uju}i grupu alatki Add.

Slika 1.22 Kao i kod
osnovnih pre~ica, sve pre~ice
na tastaturi koje budete
kreirali }e biti prikazane na
tasterima alatki pored stavki
u menijima.



Scene Editor Layout-a
Scene Editor je prikaz elemenata u va{oj
sceni, pa mo`ete zamisliti koliko }e on
biti va`an za va{ rad. Da biste ga otvorili,
izaberite opciju Open iz padaju}eg menija
Scene Editor koji se nalazi u paleti sa ala-
tkama, ili pritisnite Ctrl+F1 (slika 1.23).

Lista Item u kartici Items sadr`i prikaz svih
elemenata u va{oj sceni. Sa svakim tipom
elementa povezana je razli~ita ikona: kutija
za objekte, kost za kosti, reflektor za svetla
i kamera za kamere. Klikom na simbol za
pro{irenje (znak plus) pored svake stavke
prikazuju se kanali koji su trenutno pove-
zani sa njom, kao i pregled informacija o
njihovim klju~nim kadrovima prikazanim
na liniji vremenskog sleda. 

Klikom na znake za potvrdu koji se nalaze
u posebnoj koloni mo`ete uklju~iti ili
isklju~iti vidljivost odre|ene stavke. U
koloni sa ikonom oka  prikazan je nivo
renderovanja svake stavke, koji mo`ete
promeniti klikom na tu kolonu i izborom
novog nivoa renderovanja iz menija koji
}e se pojaviti. (Za vi{e informacija o nivo-
ima renderovanja pogledajte poglavlje 2.)
Kolona sa ikonicom katanca pokazuje da
li je element zaklju~an ili ne, ~ime se
spre~ava njegova izmena.
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Jedna od najva`nijih funkcija liste Item je
to {to ona prikazuje odnos roditelj/poto-
mak elemenata u sceni. Ako sa leve strane
elementa postoji strelica za pro{irivanje, to
zna~i da taj element ima potomke. Klikom
na ovu strelicu pro{iruje se lista koja prika-
zuje elemente potomke. Odnos roditelj/-
potomak se mo`e brzo raskinuti prevla~e-
njem elemenata u listi. (Za vi{e informacija
o uspostavljanju roditeljskog odnosa
izme|u elemenata pogledajte poglavlje 10,
“Napredne alatke za animaciju”.)

Kretanje svakog elementa mo`ete izmeniti
ili podesiti tako {to }ete ga izabrati u liniji
vremenskog sleda i promeniti njegov polo-
`aj u vremenu.  Kliknite direktno na pokret
u vremenskom sledu i prevucite ga kako
biste ga pomerili napred ili nazad u vre-
menu. Polo`aj u vremenu odre|enog
pokreta mo`ete podesiti izborom ru~ice
na jednom od krajeva vremenskog sleda i
njenim povla~enjem. 

Zaklju~avanje
Nivo 

renderovanja
Vidljivost

Lista 
elemenata

Kanali 
elemenata

Prikaz 
vremenskog 
sleda

Kontrole 
prikaza

Slika 1.23 Scene Editor je centralna lokacija za informacije o elementima u va{oj sceni. Tu mo`ete dobiti
prikaz svih elemenata i njihovih me|usobnih odnosa, kao i koristiti prikaz vremenskog sleda za brze
izmene pokreta elementa.



Hub
Hub je pozadinska komponenta LightWave
koja omogu}ava komunikaciju izme|u
Layouta i Modelera. Najjednostavniji pri-
mer za obja{njavanje te komunikacije je
slede}i: kada kreirate objekat u Modeleru i
sa~uvate ga, mo`ete nalo`iti Modeleru da
taj objekat prosledi Hubu, koji }e ga zatim
predati Layoutu. Isto tako, ako u~itate
scenu u Layout i potom se prebacite na rad
u Modeleru, Hub automatski preuzima
objekte iz te scene i u~itava ih u Modeler.
Atributi povr{ina i promene geometrije se
automatski a`uriraju izme|u Layouta i
Modelera prilikom prelaska iz jednog u
drugi. Me|utim, Modeler ne {alje automa-
tski nove objekte u Layout – to mu morate
eksplicitno nalo`iti.

Slanje objekta u Layout:
1. Iz padaju}eg menija File koji se nalazi

u paleti sa alatkama izaberite opciju
Load Object (slika 1.24). 

2. Kada se pojavi okvir za dijalog Open
File, izaberite objekat iz direktorijuma
Objects programa LightWave i kliknite
OK kako biste ga u~itali. 

3. Iz padaju}eg menija Hub u desnom
gornjem uglu interfejsa (slika 1.25)
izaberite opciju Send Object to Layout
(slika 1.26). Ako je Layout ve} aktivan,
fokus }e se prebaciti na njega, sa u~ita-
nim objektom. Ako Layout nije aktivan,
Modeler }e ga pokrenuti i potom mu
poslati objekat. 

S A V E T  

Objekat mo`ete poslati Layoutu samo ako se on
nalazi na disku. Kada radite sa novim objektima koji
jo{ nisu sa~uvani, ova komanda }e biti zatamnjena
(nedostupna). 
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Slika 1.24 U~itajte objekat kako biste ga poslali
Layoutu. 

Slika 1.25 Padaju}i meni
Hub omogu}ava brzo slanje
informacija izme|u Layouta
i Modelera. Kada se objekat
nalazi u obe komponente,
Hub }e ga a`urirati prilikom
prelaska iz jedne u drugu
komponentu.

Slika 1.26 Komanda Send Object to Layout
nala`e Hubu da u~ita aktuelni objekat u Layout.



Konfigurisanje Huba
Osim toga {to slu`i kao provodnik poda-
taka, Hub tako|e ~uva izmene konfigu-
racije Layouta i Modelera, i mo`e da im
nalo`i da automatski sa~uvaju svoje aktu-
elne podatke kao privremene fajlove za
slu~aj neo~ekivanog prekida rada. Ne
postoji ni{ta gore od toga da provedete
dosta vremena rade}i na odre|enom
objektu ili sceni, zaboravite da sa~uvate
svoj rad, i potom izgubite sve podatke
kada se aplikacija neo~ekivano zatvori.

U operativnom sistemu Windows, Hub
funkcioni{e kao aplikacija sistemske
palete (slika 1.27), a u Macintoshu kao
svaka druga aplikacija koja otvara svoj
prozor kada se pokrene. U Windowsu,
kliknite desnim tasterom mi{a na ikonu
Huba u sistemskoj paleti i iz padaju}eg
menija izaberite opciju Properties kako
biste otvorili okvir za dijalog Properties
(slika 1.28). U Macintoshu }ete morati da
se prebacite u Hub i da njegova svojstva
promenite odatle (slika 1.29).

Kliknite na strelicu pored stavke Options
kako biste videli koje su opcije dostupne.
Kliknite na opciju Automatic Shutdown
kako biste nalo`ili Hubu koliko vremena
po zatvaranju aplikacije je potrebno da
pro|e pre nego {to se i on sam isklju~i.
Kliknite na opcije Automatic Save ili Auto-
matic Project Save da biste odredili koliko
~esto je potrebno da naredi Layoutu i
Modeleru da automatski sa~uvaju svoje
aktuelne podatke.
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Slika 1.27 U operativnom sistemu Windows, Hub
je aplikacija sistemske palete.

Slika 1.28 U okviru za dijalog Properties mo`ete
konfigurisati vremenske intervale za opcije
Automatic Shutdown i Automatic Save.

Slika 1.29 Korisnici Mac-a svojstva Huba moraju
menjati direktno u njegovom interfejsu. Korisnici
Windowsa tom interfejsu mogu pristupiti duplim
klikom na ikonu Huba u sistemskoj paleti.



Rad sa fajlovima
U radu na 3D pojektima ~esto }ete kreirati
fajlove objekata i scena koje }ete snimati
na disk i u~itavati u LightWave. Zato je
dobro da znate kako se vr{e ove operacije.

Otvaranje scene u Layoutu:
1. U kartici Items kliknite na opciju Scene

ispod grupe alatki Load u paleti sa ala-
tkama ili pritisnite Ctrl+o (slika 1.30).

2. Kada se pojavi okvir za dijalog Load
Scene, prona|ite `eljeni fajl LightWave
scene, izaberite ga i pritisnite Enter ili
kliknite na Open (slika 1.31).

Snimanje scene u Layoutu:
1. Iz padaju}eg menija File u paleti sa

alatkama izaberite Save>Save Scene ili
pritisnite s (slika 1.32).

2. Ako se radi o novom fajlu scene, kada
se pojavi okvir za dijalog Save Scene
As prona|ite `eljenu lokaciju za sni-
manje, dodelite svom fajlu scene
odgovaraju}e ime i pritisnite Enter ili
kliknite na Save (slika 1.33).

Ili

Ukoliko se radi o postoje}em fajlu
scene, Layout }e vas pitati da li `elite
da fajl sa~uvate preko onog koji se
nalazi na disku. Ako `elite to da ura-
dite kliknite na Yes, a ako ne `elite
kliknite na No, posle ~ega }e se otvoriti
dijalog Save Scene As u kome mo`ete
snimiti scenu u novi fajl.

S A V E T

Ako `elite da sa~uvate novu verziju svog fajla scene
pod razli~itim imenom, upotrebite opciju Save Scene
As ili pritisnite Shift+S.
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Slika 1.30 Podmeni File>Load sadr`i sve opcije
koje se odnose na u~itavanje scena.

Slika 1.31 U okviru za dijalog Load Scene
jednostavno izaberite fajl koji `elite da otvorite.

Slika 1.32 Podmeni File>Save sadr`i sve opcije
vezane za snimanje scena.

Slika 1.33 U okviru za dijalog Save Scene As
dodelite svom fajlu scene ime, a zatim prona|ite
direktorijum u kom `elite da ga sa~uvate.



Otvaranje fajla objekta u Layoutu:
1. U kartici Items kliknite na opciju

Object u grupi alatki Load u paleti sa
alatkama, ili pritisnite + (slika 1.34).

2. Kada se pojavi okvir za dijalog Load
Object, prona|ite `eljeni fajl LightWave
objekta, izaberite ga i pritisnite Enter
ili kliknite na Load.

Otvaranje fajla objekta u Modeleru:
1. U padaju}em meniju File u paleti sa

alatkama izaberite opciju Load Object,
ili pritisnite Ctrl+o.

2. Kada se pojavi okvir za dijalog Load
Object, prona|ite `eljeni fajl LightWave
objekta, izaberite ga i pritisnite Enter
ili kliknite na Load.
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Slika 1.34 U~itajte
objekte pomo}u grupe
alatki Load.



Layout i Modeler razli~ito rukuju snima-
njem objekata. U Modeleru kreirate geome-
triju, tako da prilikom kreiranja novog
objekta imate mogu}nost odre|ivanja
imena fajla objekta. Layout koristi samo
postoje}e objekte, tako da on automarski
snima preko postoje}eg primerka
trenutno izabranog objekta.

Snimanje fajla objekta u Layoutu:
U padaju}em meniju File izaberite
Save>Save Current Object (slika 1.35).

S A V E T I

Objekat se u Layoutu obi~no snima samo posle
izmene nekog od njegovih atributa povr{ina. Ako
promenite atribut povr{ine u Layoutu i zaboravite da
sa~uvate objekat, sve izmene koje ste napravili }e biti
izgubljene slede}i put kada u~itate objekat ili scenu
koja sadr`i taj objekat. 

Ako `elite da sa~uvate primerak trenutno aktivnog
objekta pod razli~itim imenom, upotrebite komandu
Save Object Copy.

Snimanje fajla objekta u Modeleru:
1. U padaju}em meniju File u paleti sa

alatkama izaberite opciju Save Object
ili pritisnite s.

2. Ukoliko se radi o novom fajlu objekta,
kada se pojavi okvir za dijalog Save
Object As dodelite svom fajlu objekta
odgovaraju}e ime, prona|ite `eljenu
lokaciju za snimanje i pritisnite Enter
ili kliknite na Save.

Ili

Ukoliko se radi o postoje}em objektu,
Modeler }e jednostavno snimiti fajl
preko postoje}eg fajla objekta.

S A V E T

Ako `elite da sa~uvate primerak trenutno aktivnog
objekta pod razli~itim imenom, upotrebite komandu
Save Object Copy.
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Slika 1.35 Podmeni File>Save sadr`i tako|e i
opcije za snimanje objekata. 



Uvoz i izvoz objekata
drugih formata fajlova
I Layout i Modeler mogu uvesti fajlove
objekata koji su kreirani u drugim 3D
aplikacijama, {to im daje visok nivo fle-
ksibilnosti. Objekat kreiran u drugoj
aplikaciji mo`ete uvesti kao i bilo koji
drugi fajl objekta.

Modeler tako|e mo`e da izveze fajlove u
vi{e razli~itih formata 3D objekata, {to je
veoma korisno ako radite sa kolegama
koji koriste druge 3D aplikacije.

Izvoz objekta u razli~itom formatu:
1. U~itajte ili kreirajte fajl objekta u

Modeleru. ( Da biste nau~ili kako da
to uradite pogledajte poglavlje 3,
“Kreiranje geometrije”.)

2. U padaju}em meniju File u paleti sa
alatkama izaberite opciju Export, a
potom i format u kome `elite da
sa~uvate fajl.

U ovom primeru smo izabrali 3DS
(slika 1.36).

3. Kada se pojavi okvir za dijalog Save File,
dodelite fajlu objekta odgovaraju}e
ime i prona|ite `eljenu lokaciju za
snimanje.

4. Pritisnite enter ili kliknite na Save i
otvori}e se novi dijalog sa opcijama za
izabrani tip fajla (slika 1.37).

5. Kada izaberete pode{avanja izvoza,
pritisnite Enter ili kliknite na OK kako
biste okon~ali izvoz fajla.
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Slika 1.36  Opcijama izvoza objekata mo`ete
pristupiti iz podmenija File>Export.

Slika 1.37 Neke formate fajlova mo`ete konfigu-
risati, tako da }ete, ako izaberete da fajl izvezete u
nekom od njih, dobiti panel sa opcijama.



Upotreba direktorijuma
sa sadr`ajem
Direktorijum sa sadr`ajem je odli~an na~in
da organizujete svoj rad. Mnogi korisnici
kreiraju novi direktorijum sa sadr`ajem za
svaki projekat, u kome ~uvaju sve fajlove
objekata, slika i scena koji su vezani za taj
projekat. Time se olak{ava pronala`enje i
upravljanje tim fajlovima. Od vas zavisi da
li }ete izabrati da koristite jedan ili vi{e
direktorijuma sa sadr`ajem. 

Svaki direktorijum sa sadr`ajem LightWave
mora imati najmanje tri poddirektorijuma
nazvanih “Objects”, “Images” i “Scenes”, u
kojima se ~uvaju ti razli~iti tipovi fajlova.
Kada u~itavate i snimate fajlove, Layout i
Modeler otvaraju okvire za dijalog u osno-
vnom direktorijumu odabranog tipa fajla.
Na primer, kada u~itate objekat u Modeler,
okvir za dijalog Load Object se otvara u
direktorijumu Objects aktuelnog direktori-
juma sa sadr`ajem. 

Zavisno od va{eg projekta, mo`da }e vam
biti potreban i direktorijum Motions u
kom }ete ~uvati fajlove pokreta elemenata
ili podatke simulacija ~estica i mekih tela.
Neki korisnici }e mo`da `eleti da kreiraju
direktorijume Render i Preview, u kojima
}e ~uvati zavr{ene kadrove ili testove ani-
macija. Poenta svega toga je da sve fajlove
koji su povezani sa projektom dr`ite na
jednoj lokaciji koju je jednostavno na}i.

Direktorijumi sa sadr`ajem postaju jo{
korisniji kada radite sa scenama. Kada
sa~uvate scenu, reference do svih fajlova
koje su povezane sa njom se snimaju
pomo}u relativnih putanja. To zna~i da
Layout pi{e Objects/MyObject.lwo kao
referencu fajla u fajlu aktuelne scene,
nasuprot apsolutnoj putanji C:/MyContent
/Objects/MyObject.lwo. Isto va`i i za sni-
manje referenci ka fajlovima slika koje se
koriste kao povr{ine objekata. Prednost
ovoga je u tome {to svoj direktorijum sa
sadr`ajem mo`ete premestiti na drugi hard
disk, drugi kompjuter, ili ~ak pomeriti
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direktorijume Objects, Images i Scenes u
drugi direktorijum sa sadr`ajem, a Layout
}e i dalje mo}i da prona|e sve fajlove koji
su povezani sa scenom, pod uslovom da
mu nazna~ite gde se nalazi novi direktori-
jum sa sadr`ajem. Ovo je zgodna funkcija
koja omogu}ava ve}em broju korisnika da
koriste isti sadr`aj u mre`i.

Nai}i}ete i na fajlove scena i objekata koji
sadr`e apsolutne putanje. Ako slu~ajno
u~itate objekat ili sliku koji se nalaze van
aktuelnog direktorijuma sa sadr`ajem i
potom sa~uvate objekat ili scenu, fajl }e
sadr`ati apsolutne putanje. Kada slede}i
put budete u~itali fajl scene ili objekta,
Layout i Modeler }e od vas zatra`iti da
ru~no locirate fajlove koje oni ne mogu
da prona|u. Bilo bi dobro da prona|ete
ove fajlove kada to od vas bude zatra`eno
i potom ih premestite na odgovaraju}e
mesto u va{em direktorijumu sadr`aja,
ponovo u~itate scenu i sa~uvate je sa
a`uriranim informacijama o relativnim
putanjama. Time }ete spre~iti ponovno
javljanje istog problema ako premestite
sadr`aj na drugu lokaciju.

I Layout i Modeler su, po osnovnim
pode{avanjima, konfigurisani da sadr`aj
tra`e u direktorijumu u koji ste instalirali
LightWave 3D. Tu se tako|e instalira i
sadr`aj koji je oslobo|en licenci, a koji
ide uz aplikaciju. Hajde da vidimo na koji
na~in se menja aktuelni direktorijum sa
sadr`ajem. 

Promena direktorijuma sa sadr`ajem
u Layoutu:
1. Otvorite karticu Display kako biste

prikazali nove opcije u paleti sa
alatkama.

2. Kliknite na opciju General Options u
paleti sa alatkama ili pritisnite o kako
biste otvorili karticu General Options
panela Preferences (slika 1.38).

3. Kliknite na opciju Content Directory
kako biste otvorili pretra`iva~ direktori-
juma (slika 1.39).
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Slika 1.38 U kartici General
Options mo`ete konfigurisati
radni prostor Layouta, uklju~u-
ju}i i lokaciju aktualnog direkto-
rijuma sa sadr`ajem.

Slika 1.39 Pretra`iva~ direktorijuma predstavlja
brz i jednostavan na~in za izbor direktorijuma bez
nepotrebnog “{etanja” kroz fajlove.



4. Prona|ite `eljeni direktorijum sa sadr`a-
jem, izaberite ga i pritisnite Enter ili
kliknite na OK (Choose u Macintoshu)
da biste podesili direktorijum sa
sadr`ajem (slika 1.40).

Promena direktorijuma sa sadr`ajem
u Modeleru:
1. U padaju}em meniju Modeler koji se

nalazi u paleti sa alatkama izaberite
Options>General Options (slika 1.41)
ili pritisnite o, kako biste otvorili okvir
za dijalog General Options (slika 1.42).

2. Ponovite korake 3 i 4 prethodnog
postupka, “Promena direktorijuma sa
sadr`ajem u Layoutu”.
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Slika 1.40 Izaberite svoj direktorijum sa
sadr`ajem i kliknite na OK.

Slika 1.41 Radni
prostor Modelera
mo`ete konfigurisati
tako {to }ete izabrati
General Options u
podmeniju Options
menija Modeler.

Slika 1.42 U okviru za dijalog General Options
mo`ete podesiti direktorijum sa sadr`ajem.


